Détecter
les déplacements
de ton joueur

LORSQUE TU JOUES a Minecraft, tu découvres un monde que d’autres personnes
ont congu pour toi. Ce monde est amusant, mais il le serait bien plus encore si tu pou-
vais 'influencer a ta maniére. Minecraft est fait pour ¢a. Le jeu toffre l'environnement
de programmation idéal pour laisser libre cours 4 ton imagination débordante et inven-
ter des choses incroyables grice au langage Python. Ce chapitre va te montrer com-
ment profiter de cet environnement pour concevoir des choses amusantes en utilisant

Python.

Lune delles consistera A créer un jeu dans le jeu, Minecraft étant l'univers que tu
influenceras grice A ton programme. En progressant, tu verras que la plupart des pro-
grammes Minecraft se composent de trois éléments principaux qui les rendent parti-
culiérement amusants et captivants, a savoir : détecter des éléments du monde, par
exemple la position de ton joueur, calculer des opérations, comme les résultats d’'un jeu,
et animer des choses, telles que les déplacements de ton joueur.

Dans ce chapitre, tu verras comment localiser ton joueur dans le monde et provoquer
des actions de jeu en fonction de tes mouvements. Dans le jeu « Bienvenue 4 1a maison »,
tu apprendras a créer un paillasson magique qui te souhaitera la bienvenue lorsque tu
marcheras dessus. Nous t'initierons aussi a la technique du géorepérage en utilisant les
blocs barriéres de Minecraft. Et le jeu que tu vas créer te mettra au défi de récupérer des
objets plus rapidement que tes amis. Enfin, tu apprendras A propulser ton joueur dans
les airs si celui-ci reste bloqué dans un enclos trop longtemps !
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DEFILy,,

D Un programme est une série d'instructions que tu rédiges dans un langage
informatique spécifique et que I'ordinateur respecte a la lettre. Les instructions
varient selon le langage de programmation et tu dois t'assurer de les écrire
correctement. Dans ce livre, nous utilisons le langage Python.

DEFiLy,,
@& Une instruction est un terme informatique général qui signifie que tu commandes

a ton ordinateur d'effectuer une action compléte, en rédigeant par exemple
une ligne de code comme print ("Bonjour Steve"). Certains préférent
employer le terme « commande », mais il est davantage utilisé pour désigner
les ordres que tu saisis dans une invite de commandes pour que ton ordinateur
exécute une action.

Le langage Python a sa propre définition du terme « instruction », mais pour les
besoins de ce livre nous |'emploierons pour désigner un ordre ou une simple
ligne de programmation écrite dans ce langage. Si tu souhaites en savoir plus
sur le sujet, tu peux consulter la documentation en ligne en te rendant sur :
https://docs.python.org/2/

Localiser ton joueur

Avant de commencer a localiser ton joueur, tu dois d’abord savoir comment le monde
de Minecraft est congu. Ce monde est uniquement composé de blocs, chacun étant
un cube d'un métre carré. Lorsque ton joueur, Steve, se déplace, le jeu connait la posi-
tion de ton joueur grice 4 une série de coordonnées. Le monde est composé de blocs
remplis de matériaux dont le volume correspond généralement 4 un métre cube. I
existe quelques exceptions, comme les tapis et les liquides tels que l'eau ou la lave, qui
occupent un volume plus petit. Mais ils ne peuvent remplir un volume inférieur & un
meétre cube lorsquon les mélange 4 d’autres matériaux.

DEFILy,,

. e A AT g
% Une coordonnée est un ensemble de nombres qui indiquent une position. Dans
Minecraft, les coordonnées 3D sont utilisées pour indiquer la position exacte
de ton joueur dans le jeu en trois dimensions, chaque coordonnée contient donc
trois nombres. Pour en savoir plus sur les données de localisation, tu peux consulter
l'article http://en.wikipedia.org/wiki/Coordinate system. Et si tu
souhaites obtenir davantage d‘informations sur la maniére dont Minecraft traite
ces données, rends-toi sur la page http://minecraft.gamepedia.com/

Coordinates.
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Connaitre la position de ton joueur dans le monde de Minecraft te permet de provo-
quer des réactions intelligentes lorsque tu te déplaces. Par exemple, tu peux afficher
des messages dans le chat & des endroits précis, batir des structures automatiquement
lorsque tu es en mouvement et changer la position de ton joueur lorsque tu te rends
dans certains endroits. Ce livre tapprendra tous les secrets de ces formidables tech-
niques de jeu, dont la plupart se trouvent précisément dans ce chapitre !

Nous appellerons ces coordonnées x, y et z. Tu dois faire trés attention lorsque tu
parles de coordonnées de position dans Minecraft, notamment si tu utilises des termes
comme « gauche » et « droite », car la position des objets dépend de la direction vers
laquelle tu te tournes. Il est préférable de penser ta position comme si tu disposais
d’une boussole. La figure 2-1 montre comment les coordonnées x, y et z évoluent en
fonction de tes déplacements dans le jeu.

Tu comprendras plus facilement comment tes coordonnées de position évoluent
si tu les étudies directement dans Minecraft. Sur Raspberry Pi, tu peux voir
tes coordonnées x, y et z s'afficher en haut a gauche de ton écran lorsque tu
te déplaces. Sur PC ou Mag, il te suffit d'appuyer sur la touche ¥3 pour les
afficher. Pour en savoir plus sur les controles avancés du jeu, rends-toi sur la page
http://minecraft.gamepedia.com/Controls.

° xaugmente & mesure que tu te déplaces vers l'est et diminue lorsque tu vas vers I'ouest.
* yaugmente lorsque tu te rapproches du ciel et diminue lorsque tu descends.

° zaugmente 4 mesure que tu te déplaces vers le sud et diminue lorsque tu vas vers le nord.
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FIGURE 2-1 Les coordonnées x, y et z dans Minecraft correspondent aux pdles d'une
boussole comme celle-ci.
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Maintenant que tu es parvenu a exécuter le programme « Bonjour le monde de Mine-
craft » dans le premier chapitre, il est temps que tu rédiges ton propre programme et
que tu te mettes 4 jouer !

Dans le chapitre 1, nous t'avons expliqué comment faire fonctionner tous tes outils. A
présent, tu vas perfectionner tout cela dans chaque nouveau chapitre. Toutes les étapes
que tu dois connaitre pour démarrer tes applications et commencer a rédiger des pro-
grammes sont décrites dans le chapitre 1, mais pour te rafraichir la mémoire au début,
nous effectuerons quelques rappels.

Si tu souhaites te rappeler comment faire fonctionner Minecraft sur ta machine,
rends-toi sur le site Internet du livre : www.editions-eyrolles.com/
dl/14292 et regarde la vidéo intitulée « Adventure 1 » (en anglais).

1. Lance Minecraft, IDLE ainsi que le serveur si tu es sur un PC ou un Mac. Tu t'es
déja certainement un peu familiarisé avec le processus, mais n’hésite pas A relire
le chapitre 1 si tu as besoin de te rafraichir la mémoire.

2. Démarre IDLE, l'environnement de développement intégré (EDI) du langage
Python, comme tu l'as fait dans le chapitre 1. Cest 14 que tu rédigeras et exécute-
ras tous tes programmes ; c'est en somme ta fenétre sur I'univers de Python.

Pour bien comprendre comment fonctionnent les coordonnées de localisation, le mieux
est encore de rédiger un petit programme pratique. Celui que nous allons écrire dés
maintenant permet d’afficher les coordonnées 3D de ton joueur A I'écran, méme lors-
qu’il est en mouvement.

1. Dans linterpréteur de commandes Python, crée un nouveau programme via
File>New File. Une nouvelle fenétre va alors s'ouvrir dans laquelle tu vas
rédiger le code de ton nouveau programme.

2. Avant de commencer 2 écrire un programme, nous te conseillons toujours d’enre-
gistrer le fichier. Ainsi, si tu as besoin de quitter ton poste de travail, tu n’auras
pas 4 lui trouver un nom a la hate. Choisis donc de I'enregistrer, cest ce que font
tous les professionnels pour s’assurer de ne pas perdre leur travail. Pour cela,
choisis File>Save As dans le menu de l'interpréteur de commandes Python,
puis saisis le nom de ton programme : ouSuisdJe . py. Assure-toi de bien enregis-
trer ton fichier dans le dossier MyAdventures.

3. Ton programme communiquera directement avec le jeu par le biais de I'interface
de programmation (API) de Minecraft. Pour accéder a cette API, tu devras

APPRENDRE A CODER EN PYTHON AVEC MINECRAFT



importer le module minecraft qui permet i ton programme Python d’accéder a
toutes les données du jeu. Utilise le code suivant :

import mcpi.minecraft as minecraft
4. Pour communiquer avec un jeu en cours d’exécution, tu dois t'y connecter. Pour
cela, saisis la ligne suivante :

mc = minecraft.Minecraft.create()

Le langage Python est sensible a la casse. Prends donc garde a bien écrire
les majuscules et les minuscules correctement ; c'est trés important. Dans
Iinstruction que tu viens de saisir, le deuxieme terme « Minecraft » doit
commencer par une majuscule. Sans cela, I'instruction ne fonctionnera pas.

5. Ensuite, demande 4 Minecraft de te fournir les données de position de ton joueur
en utilisant getTilePos (), comme ceci :

pos = mc.player.getTilePos ()
6. Enfin, demande-lui d’afficher les coordonnées de ton joueur. print () les affichera
dans I'interpréteur de commandes Python lorsque tu exécuteras le programme :

print (pos.x)
print (pos.y)
print (pos.z)

7. Enregistre ton fichier en faisant File>Save dans le menu de I'éditeur de texte.
8. Puis exécute ton programme en cliquant sur Run>Run Module.

Tu devrais maintenant voir safficher les coordonnées de ton joueur dans l'interpréteur
de commandes Python (voir la figure 2-2). Plus loin dans ce chapitre, tu utiliseras ces
coordonnées pour connaitre la position de ton joueur dans le monde et construire un
paillasson magique qui te souhaitera la bienvenue lorsque tu marcheras dessus !

74 Python 2.7.6 Shell [o]@=8
File Edit Shell Debug Options Windows Help

Python 2.7.6 (default, Nov 10 2013, 19:24:18) [HSC v.1500 32 bit (Intel)] on win32 ;]
Type "copyright”, “credits" or "license()" for more information.

> RESTART
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FIGURE 2-2 Utilise getTilePos pour afficher la position de ton joueur dans l'interpréteur
de commandes Python.
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DEFILy,,

€ Lacronyme API (Application Programming Interface) signifie « interface de
programmation ». Une API te permet d'accéder en toute sécurité a certaines
parties du programme d’une application depuis tes propres programmes. En
I'occurrence, c’est en utilisant APl de Minecraft que tu peux accéder au jeu dans
tes programmes Python. Mais avant de connecter tes programmes Python au
jeu via cette API, tu dois tout d’abord démarrer Minecraft. Le terme mpci dans
la ligne import mcpi.minecraft as minecraft signifie Minecraft Pi, car
la toute premiére version de I’API ne pouvait s'exécuter que sur Raspberry Pi.

Une interface est un ensemble de régles qui indiquent comment, en tant que
programmeur, tu peux accéder a certaines parties du systeme d'exploitation d'un
ordinateur. L'API est un ensemble de régles qui t'indiquent comment communiquer
avec un programme en cours d'exécution —ici, le jeu Minecraft. Tous tes programmes
Minecraft auront accés au jeu Minecraft en cours d'exécution via /APl de Minecraft.

Tous les programmes Python que tu vas créer devront accéder a /APl de Minecraft. Pour
cela, tes programmes doivent étre en mesure d'accéder au module mcpi.minecraft
stocké dans le dossier mcpi de ton dossier MyAdventures. Pour garantir cet acces,
tu dois toujours enregistrer tes programmes Python dans le dossier MyAdventures.

PERCER LES SECRETS DU CODE

Félicitations, tu viens d’utiliser une variable dans ton programme ! pos.x est
une variable, au méme titre que pos .y et pos. z.

Une variable est tout simplement un nom que tu donnes a un fragment de
mémoire de ton ordinateur. Lorsque tu places un nom a gauche d'un signe
égal, cela crée une variable, a laquelle tu affectes une valeur, comme dans :

a =10

Si tu utilises une variable a I'intérieur d'une instruction print, le programme
affichera la valeur de cette variable dans l'interpréteur de commandes Python.
Dongc, si a = 10, alors I'instruction print (a) affichera le nombre 10 — la valeur
affectée a la variable a — lorsque tu y feras appel.

La variable pos que tu utilises dans pos = mc.player.getTilePos () est
un type spécial de variable. Imagine qu'il s'agit simplement d'une boite
composée de trois compartiments nommés X, y et z : print (pos.x)
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Déplace ton joueur & un autre endroit et exécute le programme 4 nouveau. Regarde main-
tenant les coordonnées qui s'affichent dans l'interpréteur de commandes Python ; celles-ci
devraient avoir changé. Tu pourras utiliser ce petit programme quand tu le souhaiteras,
notamment lorsque tu auras besoin de confirmer ta position dans le monde de Minecraft.

DEFW,»
Une variable est une donnée que tu stockes dans la mémoire de ton ordinateur. ()
Tu peux attribuer de nouvelles valeurs a tes variables n'importe ou dans tes =
programmes. Tu peux également les rappeler et les afficher ou les utiliser dans
des calculs. Pour te donner une meilleure idée de ce qu’est une variable, imagine
qu'il s'agit de la touche mémoire d'une calculatrice.
. J

Améliorer l'affichage de ta position

Avant de continuer, tu as la possibilité d’améliorer l'affichage de la position de ton
joueur pour qu'elle soit plus facile & comprendre. En effet, placer les résultats sur trois
lignes distinctes prend de la place. Il serait préférable de pouvoir les lire sur une seule
et méme ligne, comme ceci :

x=10 y=2 z=20
Pour cela, suis ces indications ci-dessous.

1. Modifie ton programme ouSuisJe.py en effacant les trois instructions
print () eten les remplacant par cette ligne :

print ("x="+str (pos.x) + "y="+str(pos.y) + "z="+str(pos.z))
2. Sauvegarde ton programme via File>Save dans le menu de I'éditeur, puis exé-

cute-le en cliquant sur Run>Run Module. Regarde comment le résultat s’affiche.
Il apparait désormais sur une seule ligne. N’est-ce pas plus clair ?

PERCER LES SECRETS DU CODE

Dans la nouvelle version de ton programme ouSuisje.py, tu as réalisé un
petit tour de magie que nous devons éclaircir ici.

En Python, l'instruction print () affiche tout ce que tu places entre les
parenthéses et le résultat apparait dans l'interpréteur de commandes Python.
Tu as déja affiché plusieurs informations a I'aide de cette instruction. Prends le
temps de les examiner un peu, en commengant par cet exemple :

print ("bonjour")

CHAPITRE 2 DETECTER LES DEPLACEMENTS DE TON JOUEUR



a4

Comme tu I'as vu, print () affiche le terme « bonjour ». Les guillemets droits
autour du mot indiquent a Python que tu souhaites afficher « bonjour » exacte-
ment comme tu |'as écrit. Si tu saisis des espaces entre les guillemets, elles
apparaitront aussi. Le texte qui se trouve a l'intérieur des guillemets s'appelle
une chaine de caracteres.

Voici un autre exemple d’utilisation de print () :
print (pos.x)

Dans cette instruction, print () affiche la valeur affectée a la variable pos . x.
Dans ce cas, il sagit d'un nombre, mais celui-ci peut varier a chaque fois que tu
utilises print (), en fonction de la valeur que tu auras affectée a la variable
affichée.

Enfin, tu dois comprendre le role de str() dans ton code. L'instruction
print () te permet de combiner des nombres et des chaines de caractéres de
plusieurs manieres. Lorsque tu rédiges des combinaisons de nombres et de
chaines dans Python, comme dans le code ci-dessous, tu dois indiquer a Python
de convertir les nombres en chaines pour pouvoir les unir aux autres caractéres
de la chaine. st () est construite a l'intérieur de Python et convertit toutes les
variables ou valeurs comprises entre ses parenthéses en chaine de caractéres.
Le symbole plus (+) indique a Python d'unir « x=. » a toute valeur affectée a la
variable pos .x pour créer une chaine compléte, qui s’affiche ensuite dans la
fenétre de l'interpréteur de commandes Python.

print ("x= " + str(pos.x))

Maintenant, essaye de saisir cette méme ligne sans stxr () et observe ce qui
se passe :

print ("x= " + pos.x)

DEF/A,,»

Une chaine de caractéres est une variable qui permet de stocker toute une
suite de lettres, de nombres et de symboles. En clair, ¢'est comme si tu enfilais
des perles sur un collier ou un bracelet, chaque perle étant ornée d'un nombre,
d’une lettre ou d'un symbole différent, le tout dans ordre bien défini et toujours
identique.

Les chaines de caractéres sont utiles dans bien des cas, notamment si tu
souhaites enregistrer ton nom, une adresse ou un message a afficher sur le chat
de Minecraft.
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Avec le programme ouSuisJe.py, tu joues & Minecraft dans la fenétre du jeu, mais
ta position apparait dans l'interpréteur de commandes Python, cest assez génant. Tu
peux facilement y remédier en utilisant une technique que tu as déja apprise dans le
chapitre 1 : postToChat ! Voild comment faire :

1. Remplace l'instruction print () par mc.postToChat (), comme ceci :

print ("x=" + str(pos.x) + " y=" + str(pos.y) + " z=" +
str(pos.z))

mc.postToChat ("x=" + str(pos.x) + " y=" + str(pos.y) + " z="
+ str(pos.z))

2. Clique sur File>Save pour sauvegarder ton programme, puis exécute-le en cli-
quant sur Run>Run Module dans le menu de l'éditeur.

Félicitations ! La position de ton joueur s’affiche désormais dans le chat de Minecraft,
ce qui doit te sembler bien plus pratique pour jouer.

Tu en conviendras, exécuter ton programme ouSuisJe.py a chaque fois que tu sou-
haites savoir ot tu es n'est pas trés pratique. Heureusement, tu peux remédier a cela en
modifiant ton programme et en y ajoutant une boucle de jeu. Presque tous les autres
programmes que tu apprendras 4 rédiger dans ce livre incluent une boucle de jeu, c'est-
a-dire un procédé qui leur permet d’interagir en continu avec Minecraft. De méme, la
plupart des jeux auxquels tu joues d’habitude continuent de tourner jusqua ce que
tu les arrétes. Cest une technique utile qu'il est bon d’acquérir. En informatique, on
appelle cela une boucle infinie, car elle tourne sans jamais s’arréter.

DEFIy,,
Une boucle infinie est une boucle qui ne s'arréte jamais. Elle tourne a l'infini (&)
et l'unique fagon de l'arréter est de mettre fin au programme Python lui- o, -
méme. Pour cela, rends-toi dans I'interpréteur de commandes Python et clique \\.
sur Shell>Restart Shell dans le menu ou, lorsque tu te trouves dans
I'interpréteur, maintiens les touches Ctrl+F6 appuyées.

Pour ajouter la boucle, tu dois modifier le programme existant. Le nouveau programme
sera trés semblable, donc tu gagneras du temps. N'oublie pas de sauvegarder ton nou-
veau fichier sous un nom différent pour ne pas écraser le premier.

1. Commence tout d’abord par enregistrer ton nouveau fichier en sélectionnant
File>Save As dansle menu de I'éditeur et appelle-le cusuisde2.py. Vérifie
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qu’il est bien enregistré dans le dossier MyAdventures, sinon il ne fonctionnera
pas.

2. Tu dois maintenant importer un nouveau module qui te permettra de ralentir le
temps. En effet, si tu ne ralentis pas la boucle, ton chat sera inondé de messages
qui t'empécheront de voir ce que tu fais. Ajoute la ligne en gras ci-dessous au
programme existant :

import mcpi.minecraft as minecraft
import time

3. Modifie ensuite la partie principale de ton programme en ajoutant les lignes en
gras suivantes, sans oublier d'indenter les lignes situées en dessous de while
True pour indiquer & Python les instructions qu’il doit répéter. Référe-toi a I'en-
cadré « Percer les secrets du code » correspondant pour connaitre la raison de
cette indentation :

while True:
time.sleep(1)
pos = mc.player.getTilePos ()
mc.postToChat ("x=" + str(pos.x) + " y=" + str(pos.y) <
+ " z=" + str(pos.z))

4. Vadans File>Save dans le menu de I'éditeur pour sauvegarder ton fichier.

5. Tu peux maintenant exécuter ton programme en sélectionnant Run>Run
Module dans le menu de I'éditeur. Fais un tour dans le monde de Minecraft et tu
verras tes coordonnées s’afficher dans le chat toutes les secondes.

PERCER LES SECRETS DU CODE

L'indentation est trés importante dans tous les langages informatiques, car
elle permet de mettre en évidence la structure des programmes et la maniére
dont s'imbriquent les blocs d'instructions. Mais elle est encore bien plus impor-
tante en Python, car le langage I'utilise pour comprendre la signification des
programmes, contrairement aux autres langages, comme le C, qui utilise des
crochets « {} » pour regrouper des instructions. Il faut notamment y faire atten-
tion lorsque tu utilises des boucles while, entre autres instructions, car elle
indique quels blocs d’instructions appartiennent a la boucle et les répétera sans
arrét le cas échéant. Dans la boucle de jeu que tu as créée, toutes les instruc-
tions se trouvant en dessous de while True: sontindentées, car elles appar-
tiennent a la boucle et seront répétées a chaque tour.

Dans I'exemple ci-dessous, tu peux remarquer que « bonjour » ne s’affiche
gu'une seule fois, tandis que « tic » s'affiche chaque seconde. Quant aux
instructions time.sleep () et print (), elles appartiennent a la boucle, car
elles sont indentées :
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print ("bonjour")
while True: # ceci est le début de la boucle

time.sleep (1)

print ("tic")
Si en Python l'indentation importe davantage que dans les autres langages de
programmation, c'est parce qu'elle permet d'indiquer, a l'aide d'alinéas, a
quelles boucles les instructions appartiennent. Si tu te trompes d’un niveau par
exemple, c’est tout le sens de ton programme que tu modifies.

programme et de regrouper plusieurs instructions en blocs distincts, sous des
boucles ou d'autres instructions. En Python, les niveaux d’indentation sont
importants, car ils permettent aussi de modifier le sens des programmes.

Lindentation est I'espace qui se situe a gauche, en marge de tes lignes ()
de programmation. Les espaces d’indentation permettent de structurer le =

Il est important que tu comprennes le role de I'indentation. Lorsque tu indentes A
ton code, tu peux a la fois utiliser des espaces et des alinéas, mais lorsque tu )
combines ces deux modes d’indentation dans un seul et méme programme, =
cela peut vite semer la pagaille. Il est donc préférable de ne suivre qu’une seule

méthode d'indentation. La plupart des gens emploient la touche Tab pour

indenter leur texte, car cela va beaucoup plus vite que d'utiliser des espaces.

Si tu suis ce choix, alors tu devras t'y tenir le reste du temps et ne pas utiliser

d’espaces.

Maintenant que tu es parvenu a exécuter une boucle de jeu infinie, ton programme
ne s'arrétera plus ! Avant d'exécuter ton prochain programme, arréte celui que tu
viens d'exécuter via Shell>Restart Shell dans le menu de I'interpréteur de
commandes ou maintiens les touches Ctr1+F6 appuyées.
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Batir le jeu Bienvenue
a la maison

Il est temps de mettre en pratique cette technique de la boucle en développant une
application simple. Le jeu « Bienvenue a la maison » détectera la position de ton joueur
pour suivre ses déplacements dans le monde de Minecraft. Tu apprendras également
a effectuer des repérages plus complexes a l'aide de I'instruction if en Python. Enfin,
tu construiras un paillasson magique qui fera apparaitre le message « Bienvenue a la
maison » dans le chat dés lors que tu passeras dessus.

Tupeuxregarderune vidéodidactique surlacréation dujeu « Bienvenue alamaison »
en te rendant sur le site Internet du livre www.editions-eyrolles.com/
dl/14292. Choisis la vidéo « Adventure 2 » (en anglais).

Pour savoir si ton joueur se trouve sur le paillasson, tu utiliseras une instruction i £ qui
te permettra de comparer la position de ton joueur avec celle du paillasson. Lorsque les
deux positions seront identiques, cela voudra dire que ton joueur est arrivé 4 la maison.

Tout d’abord, pour observer comment l'instruction if fonctionne, fais l'essai par toi-
méme dans l'interpréteur de commandes Python.

1. Clique sur l'interpréteur de commandes Python. Veille 4 bien cliquer a droite des
signes >>> pour t'assurer d’écrire ton code au bon endroit.

2. Saisis la ligne suivante dans l'interpréteur de commandes Python et celui-ci 'exé-
cutera dés que tu appuieras sur la touche Entrée. Cela n’affichera rien, mais aura
pour effet d’affecter le nombre 20 4 la variable nommeée a :

a = 20
3. Vérifie que la variable a contient la bonne valeur en saisissant I'instruction sui-
vante dans l'interpréteur de commandes Python :

print (a)

Le nombre 20 devrait apparaitre 4 'écran.

4. Essaye d’exécuter une instruction if pour voir si la valeur affectée 4 la variable a
est supérieure 4 10. Note que tu dois placer le deux-points 4 1a fin de I'instruction
if. Lorsque tu appuies sur Entrée 2 la fin de la premiére ligne, Python indente
automatiquement la prochaine ligne pour toi :
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if a>10:
print ("grand")

5. Maintenant, appuie sur Entrée A nouveau pour indiquer A l'interpréteur de
commandes que tu as terminé de saisir 'instruction if. Tu devrais voir le terme
« grand » s'afficher dans l'interpréteur de commandes. La figure 2-3 te montre ce
4 quoi ton écran doit ressembler.

File Edit Shell Debug Options Windows Help

Python 2.7.6 (default, Nov 10 2013, 19:24:18) [MSC v.1500 32 bit (Intel)] on w _*
in32

Type "copyright", "credits" or "license()" for more information.

>>> a = 20

>>> if a>10:
print ("grand")

grand
>>> |

[Ln:11]Cok: 4

FIGURE 2-3 Utiliser une instruction if de fagon interactive dans I'interpréteur de
commandes Python

Linstruction 1 £ peut générer deux résultats. Par exemple, dans le code précédent,
if a>10 est soit True — c'est-a-dire « vrai » — (a est supérieur a 10), soit False
— « faux » — (a n'est pas supérieur a 10). Les instructions i£ ne peuvent avoir que
deux résultats possibles. Nous parlerons a nouveau des valeurs True et False
un peu plus tard dans ce chapitre.

Pour que ton programme puisse calculer si ton joueur franchit le paillasson magique,
il devra vérifier au moins deux éléments de tes coordonnées. Si tu décéles que les coor-
données x et z du paillasson sont identiques & celles de ton joueur, tu pourras donc
raisonnablement en conclure que ton joueur se trouve sur le paillasson. Fais-en l'expé-
rience en utilisant le mot-clé and dans l'instruction if pour calculer les deux condi-
tions en méme temps. La coordonnée y importe moins ici. Nous n’allons donc pas la
vérifier. Ainsi, méme si ton joueur survole le paillasson, tu verras tout de méme le
message de bienvenue s'afficher.

Au préalable, effectue ces quelques étapes dans l'interpréteur de commandes Python
pour t'assurer que tout fonctionne correctement.
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1. Apreés les signes >>>, saisis les informations suivantes pour définir une variable :

a=28

2. Saisis ensuite une instruction if contenant le terme and. Cette instruction sert
a déterminer sila variable a se situe entre deux nombres. La premiére fois que tu
saisiras ce code, tu verras le terme « entre » s'afficher dans l'interpréteur de com-
mandes Python, car 8 est supérieur 4 5 et inférieur a 10. Souviens-toi d’appuyer
sur Entrée une deuxiéme fois pour mettre fin 4 I'indentation aprésle i f :

if a>5 and a<10:
print ("entre")

3. Maintenant, modifie la valeur de a pour qu'elle soit inférieure 4 5 et regarde ce
qui se passe (voir la figure 2-4) :

a=3
if a>5 and a<10:
print ("entre")

File Edit Shell Debug Options Windows Help

Python 2.7.6 (default, Nov 10 2013, 19:24:18) [MSC v.1500 32 bit (Intel)] on ﬁ
win32

Type "copyright", "credits" or "license()" for more information.

>>> a =8

>>> if a>5 and a<10:
print ("entre"™)

entre

>>> a =3

>>> 1if a>5 and
prin

>35> |

[Ln: 14|Col: 4

FIGURE 2-4 Tu utilises une instruction if avec and pour vérifier deux conditions.

A Refais I'exercice précédent en employant des nombres différents, surtout des
nombres situés entre 5 et 10. Avec quels nombres parviens-tu a afficher le

(4
w , terme « entre » ?
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Lorsque tu testes des programmes, il est toujours trés utile d'employer des
nombres différents. Pour t'éviter un nombre incalculable de tests, contente-toi de
vérifier ton instruction i £ uniqguement avec des nombres avoisinant les conditions.
Dans I'exemple précédent, il faudrait effectuer le test avec les nombres 4, 5, 6
et 9, 10, 11. Si les tests s'avérent concluants, nous pourrons raisonnablement
penser que tous les autres nombres fonctionnent aussi.

Avant de rédiger ton jeu, tu dois tout d’abord batir une structure dans le monde de
Minecraft pour donner a ton programme un contenu avec lequel il va interagir. Tout ce
dont tu as besoin, en somme, c'est d'un paillasson. Mais avant tout, démarre Minecraft
et charge le monde que tu as déja visité.

1. Pour placer un paillasson sur le sol, choisis un objet de I'inventaire et effectue un
clic droit pour le placer sur le sol devant toi. Un paillasson en bois fera parfaite-
ment l'affaire.

2. Pour connaitre les coordonnées de ton paillasson dans le jeu, exécute le pro-
gramme ouSuisJe . py & nouveau et place-toi sur le paillasson. Note les valeurs
des coordonnées x, y et z sur un papier, car tu en auras besoin au moment de
rédiger ton prochain programme pour définir la position de ton paillasson dansle
monde de Minecraft.

Tu dois probablement avoir hate de commencer A construire d'immenses structures ! Tu
apprendras 2 le faire automatiquement dans le chapitre 3, mais pour 'heure construis
une maison simple pour te concentrer sur le programme. Crée par exemple une char-
mante maison en t'assurant de placer le paillasson  l'entrée, sur le pas de la porte.

Maintenant que tu as compris comment l'instruction if fonctionne, tu peux te lancer
dans la rédaction du jeu « Bienvenue 4 la maison » en suivant les indications ci-aprés.

1. Vadans File>New File dansle menu de l'interpréteur de commandes Python
pour créer un nouveau programine.

2. Sélectionne File>Save As dansle menu del'éditeur pour sauvegarder ton pro-
gramme et nomme-le bienvenueAlaMaison.py. Noublie pas d’enregistrer
ton programme dans le dossier MyAdventures pour qu’il fonctionne.

3. Importe les modules dont tu as besoin pour ce programme en insérant les lignes
suivantes :

import mcpi.minecraft as minecraft
import time
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Connecte-toi au jeu Minecraft, en respectant bien la casse du mot Minecraft :

mc = minecraft.Minecraft.create()

Introduis la boucle principale du jeu qui permet de détecter la position de ton
joueur, en ajoutant du retard pour qu’elle ne s’exécute pas trop rapidement :

while True:
time.sleep (1)
pos = mc.player.getTilePos ()

Ajoute l'instruction i f qui permet de vérifier si ton joueur se trouve sur le paillas-
son, en utilisant and pour vérifier deux conditions. Les coordonnées x et z de ton
paillasson doivent correspondre A la position de ton joueur pour que le pro-
gramme puisse indiquer que celui-ci se trouve sur le paillasson. Tu as bien retenu
les coordonnées de ton paillasson ? Ecris-les dans ton code de cette maniére pour
que le programme puisse savoir ot il se situe exactement :

if pos.x == 10 and pos.z == 12:
mc.postToChat ("bienvenue a la maison")

Il est temps de voir si ton programme fonctionne ! Va dans Run>Run Module dans
‘éditeur tout en te déplagant dans Minecraft. Lorsque ton joueur franchit le pas de la
porte, tu devrais voir apparaitre « bienvenue 4 la maison », comme sur la figure 2-5.
Super !

maison

maison
maison
hienvenue a maison

FIGURE 2-5 Lorsque tu franchis le pas de la porte, le message « bienvenue a la
maison » s'affiche.
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Dans I'instruction i £, as-tu remarqué le double symbole == ? Une erreur fréquente
consiste a n'utiliser qu’un seul symbole =. Essaye de reproduire |'erreur et vois ce
qu'il se passe en exécutant ton programme. Python utilise le signe égal (=) une
fois pour dire : « affecte la valeur située a droite du signe égal a la variable située a
sa gauche ». Par exemple : a = 3. En revanche, Python utilise le signe égal deux
fois (==) pour dire : « compare la valeur de droite avec la valeur de gauche ». Par
exemple : a ==

Fais bien attention a l'indentation lorsque tu codes ton jeu « Bienvenue a la
maison ». Les instructions incluses dans la boucle while True sont indentées
une fois. Linstruction mc.postToChat () appartenant a l'instruction if est
indentée deux fois. Si tu te trompes dans I'indentation, ton programme sera erroné.

Que tu le croies ou non, tu viens d'acquérir les connaissances fondamentales de
programmation que tu utiliseras plus loin dans ce chapitre. Chaque programme
Minecraft comprend les étapes suivantes : importer des modules, se connecter
au jeu, former une boucle, détecter un événement et réagir en fonction de celui-
ci. A partir de ces simples fondements, tu seras capable d’accomplir de grandes
choses !

DEFI

Penses-tu qu’en vérifiant la coordonnée y (celle de la hauteur), tu parviendras a 4 ;a/
mieux détecter la position de ton joueur par rapport au paillasson ? Fais-en
I'essai. Modifie ton programme pour vérifier chacune des trois coordonnées du w ,

paillasson et regarde si cela fonctionne mieux. S 2 >\/>

POUR ALLER PLUS LOIN

A un moment donné, il t'arrivera probablement d'introduire des erreurs dans
ton code sans le vouloir. Tu verras alors un message d'erreur s’afficher dans
I'interpréteur de commandes Python. Nous te conseillons donc d‘analyser d’un
peu plus pres le type d’erreurs que tu pourrais commettre, pour ne pas t'in-
quiéter lorsque tu te trouveras dans cette situation.
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Il se peut par exemple que tu voies s'afficher une erreur de syntaxe si tu saisis
mal un symbole ou si tu rédiges ton code de maniére désordonnée. Tu obtien-
dras notamment un message d’erreur si tu omets un symbole ou si tu ajoutes
une variable au mauvais endroit.

Par exemple, si tu saisis le signe égal seul dans ton interpréteur de commandes
Python, tu verras s'afficher une erreur de syntaxe comme dans la figure 2-6, car
ce signe est généralement utilisé pour des variables ou autres informations :

7 Python 2.7.6 Shell oeEs
File Edit Shell Debug Options Windows Help

' Python 2.7.6 (default, Nov 10 2013, 19:24:18) [HSC v.1500 32 bit (Intel)] on win32 ;J
vae'"copyright", “credits” or “license()" for more information.

>>>

!SynﬁaxError: invalid syntax

R22d

Ln: 5 fCoI: 4

FIGURE 2-6 Python t'indique que ton code contient une erreur.

Maintenant, saisis la ligne suivante dans ton interpréteur de commandes

Python :
print (zz)

Tu verras que Python te signale une erreur de nom, comme tu peux le voir sur
la figure 2-7, car tu n'as pas encore affecté de valeur a la variable zz, donc
Python n’est pas en mesure de reconnaitre cette variable.

74 Python 2.7.6 Shell LIEEE
File Edit Shell Debug Options Windows Help

' Python 2.7.6 (default, Nov 10 2013, 19:24:18) [HSC v.1500 32 bit (Intel)] on win32 ;J
typel"copyright“, “credits” or “license()" for more information.
»>

| SyntaxError: invalid syntax
553
123> print(zz)

| Traceback (most recent call last):

i File "<pyshell#2>", line 1, in <module>
print(zz)

| NameError: name 'zz' is not defined

>

l:n7121CoI 4

FIGURE 2-7 Python te signale une erreur de nom.

Essaye de saisir une boucle while en omettant volontairement d'insérer le
deux-points (:) a la fin de la ligne :

while True

La encore, tu obtiendras un message d’erreur de syntaxe, car tu n‘as pas utilisé
le deux-points alors que Python les exige.
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Edit> GoTo Line dans le menu IDLE.

Ne t'inquiéte pas lorsque tu vois un message d'erreur dans ton programme.
Analyse attentivement la ligne concernée et tache de corriger I'erreur que tu as
commise. Parfois, tu obtiendras un message d'erreur de syntaxe pour une
erreur commise plus haut dans le code. Veille donc a bien analyser I'ensemble
des lignes concernées par le message pour savoir ou se situe le probléme. Si tu
n'y parviens pas, demande a un ami de le faire pour toi. Il est souvent bien plus
facile de repérer les erreurs des autres | Lorsque des erreurs sont signalées
dans l'interpréteur de commandes Python, le numéro de la ligne ou elles se
trouvent est également indiqué. Pour le connaitre, regarde en bas a droite de la
fenétre IDLE pour repérer la ligne ou se situe ton curseur, ou rends-toi dans

N\ J
DEFM//;.
La syntaxe fait référence aux regles d'un langage (en I'occurrence, le langage (&)
Python) et a I'ordre dans lequel tu saisis les informations. =
. J

Utiliser le géorepérage
pour prélever un impot

Tu vas maintenant rédiger un nouveau jeu qui s'appelle impot . py et qui te permet de
construire un pré cerné d’une barriére. Ton programme aura la possibilité de détecter
lorsque ton joueur entrera dans cet enclos et lui prélévera une somme d’argent tout le
temps qu’il passera a l'intérieur. Le défi que tu vas devoir relever consistera a retirer
des objets de l'enclos le plus vite possible pour éviter de recevoir une facture trop salée.

Dans ton programme bienvenueAlLaMaison.py, tu as utilisé une instruction if
pour vérifier siles coordonnées de ton joueur étaient identiques A celles du paillasson.
Pour le savoir, tu dois placer ton joueur précisément au méme emplacement que le
paillasson. Or, il est possible de réaliser cette tiche encore plus rapidement grice a
la technique dite de géorepérage. Clest ce que tu vas faire ici dans ton nouveau jeu.
Détecter la position de ton joueur sera d’autant plus simple que ce programme scannera
une région du monde de Minecraft au lieu de se focaliser sur des coordonnées précises.
Ainsi, tu pourras localiser ton joueur en scannant des régions entiéres et n’auras plus a
te soucier de retrouver des points précis dans l'espace.
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DEFILy,,

Plus généralement, le géorepérage est une technique qui consiste a encercler
des coordonnées sur une carte. Lorsqu’un objet pénétre dans ce périmétre
virtuel, quelque chose se produit en conséquence. Lobjet en question peut étre
n'importe quoi. Il peut s'agir d'un joueur du monde de Minecraft ou, dans le
monde réel, d'une personne, d’'une machine comme une tondeuse a gazon ou
encore d'un animal.

Dans bien des cas, la technique du géorepérage est utilisée pour avertir qu'un
objet — un troupeau ou un véhicule par exemple — sort d'un périmétre défini.
Pour en savoir plus sur I'utilisation du géorepérage en général, rends-toi sur la
page https://fr.wikipedia.org/wiki/Géorepérage. Tu y découvriras
comment le géorepérage est utilisé dans le monde réel, notamment pour suivre
le trajet des éléphants dans la nature : http://www.cbsnews.com/news/

kenya-uses-text-messages-to-track-elephant/

Pour que cette technique fonctionne, tu as besoin de deux choses : un objet ou une
région a sonder et les coordonnées du contour de cet objet. Mais avant d’entrer dans le
vif du sujet, construis un enclos 4 I'aide de barriéres Minecraft et note les coordonnées
de ses angles.

Tu n'es pas obligé de construire une barriére pour exécuter le programme, mais
cela rendra le jeu un peu plus intéressant si tu le fais. En effet, une cloture
t'empéche d'avancer, tu es obligé de sauter pardessus ou de la longer pour
trouver I'entrée de I'enclos. Or, ce sont les difficultés et les obstacles qui font
tout I'attrait des jeux. Cette barriére Minecraft constituera les limites du périmétre
de ton géorepérage virtuel et te permettra de mieux illustrer la question.

Ton enclos devrait ressembler i celui de la figure 2-8.
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FIGURE 2-8 Un enclos de 10 blocs de largeur et 10 de longueur.

Pour pouvoir géorepérer ton enclos 4 l'aide de ton programme, tu as besoin d'enregis-
trer les coordonnées de ses angles en toute fiabilité afin de stocker les valeurs dans ton
programme Python.

Le plus simple est encore d’exécuter ton programme ouSuisdJe . py puis de te diriger
vers les angles de ton enclos pour récupérer les coordonnées x, y et z de chacun des
angles. Prends un papier et dessine un schéma de ton enclos en indiquant ces coordon-
nées, car tu en auras besoin lorsque tu rédigeras ton programme. Souviens-toi que la
coordonnée z augmente & mesure que tu te déplaces vers le sud et diminue lorsque tu
te diriges vers le nord, comme tu as pu le voir dans la figure 2-1.

Dans la figure 2-9, tu peux voir les coordonnées de 'enclos que nous avons bati lorsque
nous avons rédigé ce livre. Nous avons indiqué les coordonnées des quatre angles afin
de pouvoir isoler les nombres les plus grands et les plus petits des directions x et z. Tu
remarqueras que les coordonnées les plus petites se trouvent en haut a gauche.

Ton programme de géorepérage a besoin de quatre nombres. Tout d’abord, tu dois
repérer les coordonnées x les plus grandes et les plus petites. Note-les ensuite sur ton
schéma. Dans l'exemple de la figure 2-9, la coordonnée x la plus petite est de 10 et la
plus grande est de 20. Nous avons choisi de nommer la coordonnée x la plus petite X1
et la plus grande x2.
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FIGURE 2-9 Maintenant que tu as noté les coordonnées des angles de ton enclos,
tu es prét pour la technique du géorepérage.

Selon la position de ton joueur dans le monde de Minecraft, il se peut que
certaines coordonnées soient négatives (par exemple : x=-5, y=0et z=-2), ce
qui peut compliquer un peu les calculs. Pour te faciliter la tache, déplace-toi dans
le monde de Minecraft afin d’obtenir des coordonnées positives (par exemple :
x=5, y=2, z=4). Si tu disposes d'un Raspberry Pi, les coordonnées de ton joueur
s'affichent en haut a gauche de ton écran de jeu. Si tu disposes d'un PC ou d’un
Mac, appuie sur la touche F3 pour les afficher.

Ensuite, tu devras calculer les plus petites et les plus grandes coordonnées z. Dans
l'exemple de la figure 2-9, la coordonnée z la plus petite est de 10 et la plus grande est
de 20. J’ai choisi de nommer la coordonnée z la plus petite z1 et la plus grande z2 :

X1 =10
Z1l = 10
X2 = 20
Z2 = 20

Tache d’attribuer le méme nombre 4 tes coordonnées les plus grandes et les plus petites,
car tu en auras besoin pour rédiger ton programme par la suite.
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La derniére étape consiste a rédiger le programme qui va mettre la technique du géorepé-
rage en pratique et prélever une somme d’argent dés lors que ton joueur entrera dans l'en-
clos. Ce programme est structuré de la méme maniére que le programme ouSuisde . py.

Tu vas également utiliser ce quon appelle des constantes dans ce nouveau jeu. Tu
pourras ainsi déplacer ton enclos plus facilement si besoin et n’auras pas a fouiller dans
tes programmes 4 la recherche des valeurs 4 modifier pour réaliser cette action.

Comme pour une variable, une constante est le nom qu‘on donne a un fragment
de mémoire dans lequel tu peux stocker des valeurs qui restent identiques a §
chaque fois que le programme s’exécute. \,

Contrairement aux autres langages de programmation, Python ne dispose pas
vraiment de maniére de gérer les constantes. En revanche, pour pallier cela, les
programmeurs Python utilisent généralement des conventions de programmation
(c'est-a-dire une méthode). lIs écrivent notamment les constantes en lettres
capitales pour pouvoir les reconnaitre plus facilement et ainsi ne pas en modifier
la valeur initiale. Les autres langages de programmation ont leur propre méthode
pour reconnaitre les constantes et dés lors qu’on essaye d’en changer la valeur,
ils affichent un message d’erreur. Le langage Python ne dispose pas de cette
particularité.

Passons maintenant a la rédaction du programme.
1. Ouvre tout d’'abord une nouvelle fenétre dans IDLE en sélectionnant File>New
File dans le menu de l'interpréteur.
2. Choisis File>Save As dansle menu et nomme ton fichier impot . py.
3. Importe les modules dont tu as besoin pour ce programme :
import mcpi.minecraft as minecraft
import time
4. Connecte-toi au jeu Minecraft :
mc = minecraft.Minecraft.create ()
5. Tu dois maintenant définir les valeurs des constantes de tes quatre points de
géorepérage. Utilise les coordonnées que tu as calculées tout a 'heure. Pour ce qui

nous concerne, nous avons repris les coordonnées de notre programme, mais il
se peut que les vétres soient différentes :

X1 = 10
Zl1 = 10
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X2 20
Z2 = 20

6. Crée ensuite une variable qui conservera un registre des impdts prélevés au
joueur. Comme ton joueur n'aura pas encore subi de prélévement d'impét au
début du jeu, tu dois créer une nouvelle variable que tu nommeras impot et que
tu mettras a zéro :

impot = 0

7. Crée la boucle principale de ton jeu avec une instruction while pour faire tour-
ner ton programme. Comme il va tourner sans arrét, utilise I'instruction sleep
pour le retarder d'une seconde entre chaque tour, cela te donnera en outre une
idée du temps que ton joueur passe dans l'enclos. Plus tard, tu ajouteras 1 a la
variable impot aprés chaque tour de boucle. Comme tu ralentis la boucle d'une
seconde, cela veut dire que I'impét augmentera de 1 toutes les secondes. Respecte
bien I'indentation des lignes 4 partir de cette étape :

while True:
time.sleep (1)

8. Pour savoir si ton joueur se trouve dans le périmétre de géorepérage, tu
dois connaitre sa position. Comme dans tes précédents programmes, utilise
player.getTilePos () pour le savoir :

pos = mc.player.getTilePos ()

9. Tu es maintenant arrivé i I'étape la plus importante du programme. Cest ici que
tu vas indiquer 4 ton programme d’utiliser les quatre coordonnées que tu as cal-
culées plus tét pour savoir si ton joueur se situe dans le périmétre et, si cest le
cas, pour lui prélever un impét tout en le lui signalant dans le chat. Pour cela,
saisis :

if pos.x>X1 and pos.x<X2 and pos.z>Z1 and pos.z<Z2:
impot = impot+1l
mc.postToChat ("Tu dois la somme de :" + str(impot))

A ce stade, tu dois faire trés attention a la maniére dont tu indentes ton code.
Python utilise I'indentation pour reconnaitre les blocs d‘instructions. Comme
tu peux le remarquer, les instructions qui se trouvent en dessous de while
True: sont indentées d'un cadratin. Cela permet a Python de savoir que ces
instructions appartiennent a la boucle while. Mais, regarde l'instruction if de
plus prés : les deux lignes qui la suivent du programme sont indentées d'un
cadratin supplémentaire. Cela veut dire qu’elles font partie de I'instruction if et
qu’'elles s'exécuteront uniquement si ton joueur se trouve dans I'enclos.

60 APPRENDRE A CODER EN PYTHON AVEC MINECRAFT



Sauvegarde ton programme a nouveau et exécute-le en sélectionnant Run>Run
Module dans le menu de Iéditeur.

Amuse-toi A entrer et sortir de l'enclos avec ton joueur. Lorsque tu es dans l'enclos, tu
dois voir apparaitre toutes les secondes dans le chat un message t'indiquant le montant
de l'impét que tu dois payer. Lorsque tu en sors, le calcul de ton impét s’arréte. Enfin, il
ne t'aura certainement pas échappé qu’a chaque fois que tu retournes dans l'enclos, ton
programme se souvient du montant que tu dois payer.

DEFI

Pour que le jeu soit plus amusant, tu dois donner une mission a ton joueur.
Crée quelques blocs a l'intérieur de I'enclos, puis fais fonctionner ton pro-
gramme a nouveau. Le but est de récupérer tous les blocs en payant le moins
d'impdts possible. Il te suffit de briser les blocs pour les récupérer. Méme si ton
programme ne reconnait pas ces actions, cela rendra le jeu bien plus intéres-
sant. Tu peux encore t'amuser a parsemer toutes sortes d'objets inventés dans
ton enclos et inviter tes amis a relever le défi de les glaner en payant le moins
d'impéts possible. Alors, a toi de jouer !

Déplacer ton joueur

Il existe un moyen de rendre ton jeu encore plus captivant en faisant notamment appel
4 une autre fonctionnalité de 'API de Minecraft que tu trouveras bien utile par la suite.
1l s'agit de transporter ton joueur & un autre endroit dans Minecraft ! Pour cela, tu
devras modifier ton programme impot .py et lui ajouter la possibilité d’éjecter ton
joueur de l'enclos s’il y reste plus de trois secondes. Tu devras alors revenir dans l'enclos
pour récupérer tes blocs.

Tu devras tout d’abord localiser un point en dehors de I'enclos ol tu souhaites que ton
joueur atterrisse. Le moyen le plus simple d’y parvenir est d’ajouter 2 points aux coor-
données X et Z les plus grandes de ton enclos pour obtenir d’autres coordonnées. Pour
rajouter un effet spectaculaire A ton action, choisis une coordonnée Y 4 une altitude
élevée. Le nombre que tu choisiras dépendra de l'altitude a laquelle tu as construit ton
enclos, mais si ce dernier se trouve 4 une hauteur de y = 0, tu pourrais choisir par
exemple une hauteur de 10. Ton joueur sera alors propulsé dans les airs et la gravité le
fera retomber sur terre.

Tu vas donc modifier ton programme impot . py pour éjecter ton joueur hors de l'en-
clos s'il y reste plus de trois secondes, en suivant ces instructions.

1. Définis trois nouvelles constantes au début de ton programme pour indiquer la
position d'un abri. Cet abri se trouvera juste en dehors de 'enclos et lorsque ton
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joueur sera éjecté, il atterrira a cet endroit précis. Les nouvelles lignes a ajouter

sont en gras :
X1 =10
Z1l = 10
X2 = 20
Z2 = 20

ABRI X=X2+ 2
ABRI Y= 10
ABRI Z = Z2 + 2

2. Tu vas maintenant préciser le temps que ton joueur peut passer dans l'enclos.
Pour cela, tu dois créer une autre variable que tu peux appeler dansEnclos.
Affecte-lui le nombre de secondes que ton joueur peut passer dans I'enclos. Elle
va alors I'éjecter lorsqu'il aura passé trop de temps 4 l'intérieur. L encore, n’ajoute
que les lignes marquées en gras a ton programme :

impot = 0
dansEnclos = 0

3. Saisis ensuite une ligne de code pour incrémenter la variable dansEnclos de 1
lorsque ton joueur se trouve dans I'enclos. Pour cela, ajoute le code en gras :

if pos.x>X1 and pos.x<X2 and pos.z>Zl1 and pos.z<Z2:
impot = impot+1l
mc.postToChat ("Tu dois la somme de: " + str(impot))
dansEnclos = dansEnclos+l

4. Tu vas maintenant procéder a I'ajout d’'une instruction else pour que le pro-
gramme remette le compteur dansEnclos & zéro aprés que ton joueur a été
éjecté en dehors I'enclos. Fais bien attention 4 indenter I'instruction else correc-
tement pour que Python interpréte bien ton code. Nous t'expliquerons un peu
plus tard 4 quoi servent l'instruction else et le symbole # que tu vas utiliser.
Pour 'instant contente-toi de saisir le code en gras :

mc.postToChat ("Tu dois la somme de:" + str(impot))
dansEnclos = dansEnclos+1l

else: # en dehors de l1l’enclos
dansEnclos = 0

5. Enfin, ajoute quelques lignes de code supplémentaires 4 la fin de ton programme
pour propulser le joueur dans les airs il reste dans 'enclos plus de trois secondes.
La gravité le fera retomber sur terre et il pourra alors se ruer vers I'enclos 4 nou-
veau. Ce code doit se trouver tout a la fin de ton programme. L'instruction if
doit étre indentée d'un cadratin, car elle fait partie de laboucle while Trueetle
bloc d'instructions qui suit i f doit étre indenté de deux cadratins, car il fait par-
tie du if. Saisis le code suivant :
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if dansEnclos>3:
mc.postToChat ("Tu es trop lent !")
mc.player.setPos (ABRI_X, ABRI Y, ABRI Z)

6. Sauvegarde ton programme et exécute-le en cliquant sur Run>Run Module dans
le menu de I'éditeur.

Tu vas bien t'amuser maintenant, car tu vas devoir redoubler d’ingéniosité pour entrer
et sortir de l'enclos sans te faire éjecter | Comme tout a 'heure, sélectionne une série
d’objets a parsemer dans ton enclos et lance un défi 4 tes amis : qui de vous tous rem-
portera cette folle course contre la montre en glanant le plus de blocs possible sans y
laisser trop de plumes (voir la figure 2-10) ?

i Minecraft 1.6.4 [SEES

FIGURE 2-10 lon joueur est propulsé dans les airs lorsqu’il reste trop longtemps dans
I'enclos.

PERCER LES SECRETS DU CODE

Tu viens d'utiliser deux nouveaux éléments du langage Python. Il est temps de
les approfondir un peu.

Tout d'abord, tu as utilisé I'instruction else, un mot-clé qui vient compléter
I'instruction i£. Il doit toujours se trouver au méme niveau d’indentation que le
if auquel il est associé et les instructions que tu souhaites rédiger sous else
doivent aussi étre indentées. En voici un exemple :

if a>3:
print ("grand")
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else:
print ("petit")

Si la variable a renferme une valeur supérieure a 3, Python affichera « grand »
dans l'interpréteur de commandes, sinon (else), c'est le terme « petit » qui
s'affichera. Autrement dit, si a>3 est vrai, alors le mot « grand » s’affichera,
mais si a>3 est faux, alors c’est « petit » qui s'affichera.

Une instruction if ne s'accompagne pas forcément d'une instruction else ;
celle-ci est optionnelle. Mais tu auras parfois besoin de traiter la condition vraie
différemment de la condition fausse.

Le deuxiéme élément que tu as utilisé est un commentaire. Tu verras qu'il est
parfois bien utile de laisser un commentaire en marge de ton code pour te sou-
venir de certaines choses ou pour donner des indications a un autre lecteur.

Les commentaires commencent toujours par le symbole # :
# ceci est un commentaire

Tu peux laisser un commentaire n‘'importe ou sur tes lignes de code. Dés lors
que tu utiliseras le symbole diése, tout ce qui suivra jusqu'a la fin de la ligne
sera ignoré par Python.

Explorer d'autres pistes
de localisation

Dans ce chapitre, tu as appris 4 mettre en pratique les fondements d’une boucle de jeu
et 3 utiliser les techniques de localisation et de géorepérage pour créer un jeu amusant.
Lorsque tu crées des jeux, nous te recommandons vivement d'inviter tes amis et ta
famille 4 y jouer et de leur demander leur avis. C'est le meilleur moyen d'obtenir des
conseils qui t'aideront & améliorer tes jeux.

* Lejeu « Bienvenue 4 la maison » est amusant, mais il a un probléme : si ton joueur
franchit le pas de la porte, il ne cesse d’afficher « Bienvenue 4 la maison » et cela
t'empéche de bien voir. Peux-tu trouver un moyen de modifier le programme pour
qu'il ne te salue qu'une seule fois lorsque tu entres chez toi ?

* Une bonne technique pour trouver de nouvelles idées est de découvrir d’autres jeux
et d'observer comment ils tiennent les joueurs en haleine. Sois curieux, joue 4 d’au-
tres jeux et fais une liste de toutes les caractéristiques que pourrait contenir un bon
jeu, notamment en ce qui concerne le déplacement du joueur.

¢ Effectue des recherches sur Internet au sujet de la technique du géorepérage et vois
comment l'industrie en fait usage. Si certaines idées t'intéressent, lance-toi dans
I'écriture d’'un programme Minecraft qui en reprend les principaux aspects, en util-
isant les connaissances que tu as acquises dans cette aventure.
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Tableau de références

Importer 'API de Minecraft Se connecter a Minecraft

import mcpi.minecraft as minecraft mc = minecraft.Minecraft.create()

Obtenir la position du joueur Afficher un message dans le chat
de Minecraft

pos = mc.player.getTilePos () mc.postToChat ("Bonjour Minecraft")
X = POsS.X
y = pos.y

Zz = pos.z

Définir la position du joueur

x =5
y=3
z =17

mc.player.setTilePos (x, y, z)

Niveau terminé : Tu as créé un super jeu qui réagit de plusieurs maniéres en fonction
des déplacements de ton joueur dans Minecraft.

Dans le prochain chapitre...

Dans le chapitre 3, tu vas apprendre a construire de grandes structures, telles que
des maisons, de fagon automatique en utilisant des blocs et des boucles Python.
Avec un seul programme Python, tu as la possibilité de batir d'immenses structures
bien plus vite que si tu les construisais a la main. Tu pourras ainsi concevoir une ville
entiére en un rien de temps.

J
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